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1. A=BUEKLED

AT H PIC24FJ128GA010 #a4diti k. (Plug-In Module, PIM) %2 s 5% Explorer
16/32FF KR FILED. B2(5 5, WS WHEBT “IREUKAFFRELE" .

// PIC24FJ128GA010 Configuration Bit Settings

// For more on Configuration Bits, --&—— {FZWLFE117
// consult your device data sheet

// CONFIG2

#pragma config POSCMOD = XT // XT Oscillator mode selected

#pragma config OSCIOFNC = ON // 0OSC2/CLKO/RC15 as port I/O (RC15)
#pragma config FCKSM CSDCMD // Clock Switching and Monitor disabled

#pragma config FNOSC = PRI // Primary Oscillator (XT, HS, EC)
#pragma config IESO = ON // Int Ext Switch Over Mode enabled
// CONFIG1

#pragma config WDTPS = PS32768 // Watchdog Timer Postscaler (1:32,768)
#pragma config FWPSA = PR128 // WDT Prescaler (1:128)

#pragma config WINDIS = ON // Watchdog Timer Window Mode disabled
#pragma config FWDTEN = OFF // Watchdog Timer disabled

#pragma config ICS = PGx2 // Emulator/debugger uses EMUC2/EMUD2
#pragma config GWRP = OFF // Writes to program memory allowed
#pragma config GCP = OFF // Code protection is disabled

#pragma config JTAGEN = OFF // JTAG port is disabled

// #pragma config statements should precede project file includes.
// Use project enums instead of #define for ON and OFF.

#include <xc.h> - FEWFE1.27
int main(void) {
unsigned char portValue = 0x55; -#—— i5&NE1.377

// Port A access -#4—— {ESWNFE1.47

ADIPCFG = OxFFFF; // set to digital I/0 (not analog)
TRISA = 0x0000; // set all port bits to be output
LATA = portValue; // write to port latch

return 0;

DS50002446C_CN #5271 © 2018-2020 Microchip Technology Inc.
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1.1 BB
Microchip 23 F B A L B 247 2%, LA B9z a] B g8/ 8l i & 23 FIhRE

HE: WRARIEWBEREN, SPRIEET, B AEEIET. I

1.1.1 B E WA E AL

TR R LA LI

« RGAEFE— TGRSR ER UL . W E AR, A0 A
EaE T, WEFOS, JFARBE M mE R 0] AR A I R
#pragma config FNOSC = PRI
#pragma config POSCMOD = XT

o F1100E I 28— DA D N AR e I g . XRERT B L B AR E L. R A
KLU R

#pragma config FWDTEN = OFF

o ARD IR ——AE W B R PR CR Y o XA AT T OR 257 7 i 7 F) 6 £ 0 o 7)o
HIAE ARG G T

#pragma config GCP = OFF

AR 16 2231 (MTAEA R Bl I MCUD B, FTRET B B AR AR E L. 1
2 LBV AR B T OM T M RS B AL I 44 BR R Th BB T fE A e S 7
https://www.microchip.com |48 2 AH 5 ) 5085

A REF TR EA N E ZE 8, 152 IMPLAB XC16 %234 5545 T I F S A
MPLAB XC16 Installation Directory/docs/config index.html
1.1.2 W BB

7EMPLAB X IDE ', W]1# ] Configuration Bits (Fit B7) & & H M B ix Ll ., i
% £ Window>PIC Memory Views>Configuration Bits (% I'1>PICTZ %2540 &> B 1)

N
% E .
E1. Configuration Bits& 1
Configuration Bits # ‘
q_}, Rddress Name Walue Field Opticn Category Setting
a 157FC CONFIGZ FR9D BOSCMOD XT Primary Oscillator Select ¥T Oscillator mode selected
. OSCIQFNC ON Primary Oscillator Output Function OSC2/CLED/RC1S functiona as port I/0 (RC1S)
'f-'i‘ FCESM CSDCHMD Clock Switching and Monitor Clock switching and Fail-Safe Clock Monitor are disabled
“\7;‘_1 FNOSC BRI Oacillator Select Primary Oscillator (XTI, HS, EC)
- IESO o Internal External Switch Over Mode IESO mode (Two-Speed Start-up) enabled
157FE CONFIGL ‘31“71“ WDTES B532768 Watchdog Timer Postscaler 1:32,768
—|] FWESA PR128 WDT Prescaler Preacaler ratio of 1:128
EM’ WINDIS oN Watchdog Timer Window Standard Watchdog Timer enabled, (Windowed-mode is disabled)
FWDTEN OFF Watchdog Timer Enable Watchdeg Timer is disabled
Ics BGx2 Corm Channel Select Emulator/debugger uses EMUC2/EMUD2
GWRE OFF General Code Segment Write Protect Writes to program memory are allowed
GCP OFF General Code Segment Code Protect Code protection is disabled
JIAGEN [OFF - |JTBG Port Enable JIAG port is disabled -
Memoary | Configuration Bits - Format |Read/Write - | o nie Eoner Eode Ot ”

IR E )G, £FERNLEBIGAL R, )5 Fdiinsert Source Code in
Editor ({E4mfH a8 i AR EiAbR, WoRBAREH R, T IE O rE 215
B, %2 IMPLAB X IDECHY.
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1.2 Lff<xc.h>

WS SO 7O VR YR SO A ARG U5 1] 2 128 2 AR5 58 B A AR )2 I D RE . T /£ MPLAB XC16
2 H F W) support F H 3 N KRk S04 A1 HoAth Sk S04

IR AR B I BB R BN 22, UME xc . h 8 M IERf I #3400tk . 38
¥ 2 AR e 1Sk SO A TR IS AR R, B S BRI A i A

1.3 HTLEDEKZE

Wmr—9pik, EE5ANLEDFEERES — 1N ®E (portvalue) , EILED D3.
D5. D7 f1D9¥4 fi5%, LED D4. D6. D8 FID10K K K. 4 F i b R 3 AL B 1145
B, B WEBY “IREAFMEELE”
1.4  sHAVFH
UL IVO B T 540% VOB IE H . AR L a0 UE B 1/0, /2R 1k Ah 4k
Wo AL, Al HAARERINE TR LA CA R, XA RS T4 include H
KR BIAR AR B Sk SO R . DG TR A iz R F WL 5 RIS S, T S L AR 1 £k
P F
XEF AT ARG, a1 A G| ERIASE L AME R . i 5] BRI 15 B L,
MR E eI B NET1/0:

ADIPCFG = OxFFFF; // set to digital I/O (not analog)
RS EEE BB FI/OGE O (PORT) EN4IFES (LAT) H1Fes. wHH i H
LATA. %:LEDS ON_OFFR{E4HI1f7 2%

LATA = LEDS_ON _OFF; // write to port latch
HAh, IBF A A TR E I B 7 m RS 2, BN TRISFHfids. &
B RE TRISDAI TRISB. WAL BN 0 vl I I N, AR E N1
I NEIN o X T AR

TRISA = 0x0000; // set all port bits to be output

DS50002446C_CN 54 71 © 2018-2020 Microchip Technology Inc.
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2. {HFHIERT REUE LEDIA %

AR GIAE bR BACHS B B Atk B BEAT 2 2. A AL A LED, R LED &2 #
INER

// PIC24FJ128GA010 Configuration Bit Settings

// For more on Configuration Bits, consult your device data sheet

// CONFIG2

#pragma config POSCMOD = XT // XT Oscillator mode selected

#pragma config OSCIOFNC = ON // 0OSC2/CLKO/RC15 as port I/O (RCL5)
#pragma config FCKSM CSDCMD // Clock Switching and Monitor disabled
#pragma config FNOSC PRI // Primary Oscillator (XT, HS, EC)
#pragma config IESO = ON // Int Ext Switch Over Mode enabled

// CONFIG1
#pragma config WDTPS = PS32768 // Watchdog Timer Postscaler (1:32,768)
#pragma config FWPSA = PR128 // WDT Prescaler (1:128)

#pragma config WINDIS = ON // Watchdog Timer Window Mode disabled
#pragma config FWDTEN = OFF // Watchdog Timer disabled

#pragma config ICS = PGx2 // Emulator/debugger uses EMUC2/EMUD2
#pragma config GWRP = OFF // Writes to program memory allowed
#pragma config GCP = OFF // Code protection is disabled

#pragma config JTAGEN = OFF // JTAG port is disabled

// #pragma config statements should precede project file includes.
// Use project enums instead of #define for ON and OFF.

#include <xc.h>
#include <libpic30.h> <#—— {FSWNE2.17

int main(void) {
unsigned char portValue;
// Port A access
ADIPCFG = OxFFFF; // set to digital I/O (not analog)
TRISA = 0x0000; // set all port bits to be output

while (1) { <-—— FSWFE2.2

portValue = 0x55;
LATA = portValue; // write to port latch

// delay value change -<-—— HESNEHE2.37
__delay32(1500000) ; // delay in instruction cycles

portValue = 0xAA;
LATA = portValue; // write to port latch

__delay32(1500000) ; // delay in instruction cycles

}

return -1;
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21 FEket

TEAAF) 1, Af H libpic30 4w ¥ &% FE o i delay32 () Bi#k. Uil Z R, 4
& 1ibpic30.he

2.2 while() EAMEZEE

g A EIILED RAEZL, B NE & portvaluelfiox55 (LED 0, 2, 4, 6 /4
58, AR RIZE R EAME 0xAn  (LED 1,3,57 mis) o I T while (1) HUATHE

2
AR TR HCR E], SRS AR IR, KDy while fE 3R I8 % A RSR . BRI, KR [E -1
RN IR

23 _ delay32() B#
L AT T2 P8 K 22 B 0 #5455 55 LED 1 DRk B 11 IR IR 0 e 77, PRI 7R
FRRHATHSE . _ delay32 () 4w PE a8l LU A0 22 R 2

AR MBI EZFEANGEL, HSUS%FM (6AEF T A K E)
(DS51456D_CN) .
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3. Sl E A ZERT 7E LED | B 1145
FRIE b R BTG B KRl AT 00 AT b — R 181 o £ ZE IR B B0 T PR A 0
FRHATEEIRAE L, (R e R b o A2y 1], 3 G i — a0 B, AT {af P o i 52
H T

// PIC24FJ128GA010 Configuration Bit Settings

// For more on Configuration Bits, consult your device data sheet

// CONFIG2

#pragma config POSCMOD = XT // XT Oscillator mode selected

#pragma config OSCIOFNC = ON // 0OSC2/CLKO/RC15 as port I/O (RC15)
#pragma config FCKSM = CSDCMD // Clock Switching and Monitor disabled
#pragma config FNOSC = PRI // Primary Oscillator (XT, HS, EC)
#pragma config IESO = ON // Int Ext Switch Over Mode enabled

// CONFIG1

#pragma config WDTPS = PS32768 // Watchdog Timer Postscaler (1:32,768)
#pragma config FWPSA = PR128 // WDT Prescaler (1:128)

#pragma config WINDIS = ON // Watchdog Timer Window Mode disabled
#pragma config FWDTEN = OFF // Watchdog Timer disabled

#pragma config ICS = PGx2 // Emulator/debugger uses EMUC2/EMUD2
#pragma config GWRP = OFF // Writes to program memory allowed
#pragma config GCP = OFF // Code protection is disabled

#pragma config JTAGEN = OFF // JTAG port is disabled

// #pragma config statements should precede project file includes.
// Use project enums instead of #define for ON and OFF.

#include <xc.h>

// Interrupt function (CCI) < FEE3AT
void _ interrupt(no auto psv) TlInterrupt (void) {

// static variable for permanent storage duration

static unsigned char portValue = 0;

// write to port latch

LATA = portValue+t+;

// clear this interrupt condition

_T1IF = 0;

int main (void) {

// Port A access
AD1PCFG = OXFFFF;
TRISA = 0x0000;

// set to digital I/0 (not analog)
// set all port bits to be output

// Timerl setup - FHESNFEI27

TI1CON = 0x8010; // timer 1 on, prescaler 1:8, internal clock
_T1IE = 1; // enable interrupts for timer 1

_T1IP = 0x001; // set interrupt priority (lowest)

while (1) ;

return -1;
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3.1 TR

A @A CHD (CCD () interrupt () Ut BT o E s o o Wy ki £, Bt A1,
BN 45 € FE 45 8 A WP (Program Space Visibility, PSV) . AR L fai #, R
fEHEMPSV. A 5PSVIHELZELE, 5 W (MPLAB® XC16 C 4 & 1l F fa )
(DS50002071E_CN) .

R E T Timert Wi AR T1Interrupt (). i 2% H M docs XHF ¥k
TR T AR R R R

TERW R EF, T+ portvalue & 1E Timer1 P28 Hh B B

3.2 TimerliZg

T ASAE B AE P W AR ST RE e AT, DRI IE R 1) AR R AN N A S ACRY LA RE
ANBLE I &5+ FOVFRE 45 Fh 7 LA K S e Bt A 4 T A
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4. f#F ADCYE LED I &R B iy 834H
AT/ 5 bR A4 B A R 284 DA B3 1A LED . EZEASRB b, B FH S il
HALAs CEEY MEE S I O B AR % 2% (Analog-to-Digital Converter, ADC)
N, NEFATHAI BoRAELED F.
RIBLEFFENRE, Wil HMPLABUILAL E# (MPLAB Code Configurator, MCC)
4 . MCC £ — & #fi £, 7 7 MPLAB X IDE 3¢ # Tools>Plugins ( T. B> &) )
Available Plugins (W H#diff) &I~ T3, ARUNMLZEEHFNEZEE, S
. MPLAB X IDE #; 1.

HXMCCHIZ 35 KL K (MPLAB®R LA B 841 457 )  (DS40001725B_CN)
WE Vi LR URL H1f MPLAB RS B B 2% W) 7T«
https://www.microchip.com/mplab/mplab-code-configurator

ARG T MCC I E AN AR % B .
RGHER

2. ADCYi H %8

Projects | Files | Services |Cl.asses | Resource Management [MCC] 22 =]

Project Resources Generate | Import.. | Export

¥ System
Interrupt Module
Pin Module
System Module
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K 3. ADCIi B RGHERELE

u:»u1| Start Page ﬁ| Pin Module 88| InterruptModule 22| System Module = l‘_l_’JE@
System Module 8 ©

€01 Easy Setup | =] Registers

¥ Clock

E000000 | - |Hz‘ FRC Oscillator | - ‘ (8.0 MHz) Clock Source

‘ » [_] FRC Postscaler |

8 MHz Fosc

4 MHz Fosc/2

Clock Cutput Pin Configuration | OSC2/CLKO/RCLS functions as CLKO (FOSC/2) | - |

I:' Use Secondary Oscillator (31 - 33) kHz

[_] Enable Clock Switching
I:' Enable Fail-5afe Monitor

¥ ICD

Emulator Pin Placement | Emulator/debugger uses EMUC2/EMUD2 | -

¥ Watchdog

Enable‘ Watchdog Timer is disabled I = I

‘ Clock Settings ‘

Maode | Standard Watchdog Timer enabled,(Windowed-mode is disabled) I - I

Timer Prescaler | Prescaler ratio of 1:128 I - I

Timer Postscaler | 1:32768 -

Time-out Pericd  135.300s

DS50002446C_CN %510 7T © 2018-2020 Microchip Technology Inc.
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4. ADCi H ADC1i% £

Device Resources | ’ | M

¥ Documents
PIC24F)128GA010 Product Page
¥ Peripherals
v SoADC
v BgapCl
ADC1 [Foundation Services Library by Microchip Technelogy, Inc.]
ADCI [PIC24 / dsPIC33 / PIC32MM MCUs by Microchip Technology, Inc.]

» —CVR

Double click in "Device Resources” to open in "Project Resources”

Prdjects |Fi|.es | Services Clazsses Resource Management [MCC] =]

Hroject Resources Generate | Import.. | Export

¥] System

Interrupt Module
Pin Module
System Module
¥] Peripherals

¥ %5 ADC1 [PIC24 / dsPIC33 / PIC32MM MCUs by Micrachip Technalagy, Inc]

PIC24/dsPIC33/PIC32MM MCUEF: i /& m] LUt Easy Setup (32FAi
B MEBEETMEATRE.

Foundation Services Library (GEREARSSE) A EEOAME, @R
PEAME R EE AT BE, JFAT R B AR

© 2018-2020 Microchip Technology Inc. DS50002446C_CN #1171
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K 5. ADCJYji § ADC1fic B

@Output $| StartPage  ®| PinModule 22| Interrupt Module

| SystemModule 82| ADC1 =

ADC1

£0% Easy Setup | [ Registers

¥ Hardware Settings

Enable ADC

Enable Auto Sampling

ADC Clock

Conversion Clock Source | FOSC/2

Differential Sampling | AVSS

C ion Trigger | Intemnal counter ends sampling and starts conversion | it |

Conversion Clock 1 TCY
Qutput Format | Absoclute decimal result, unsigned, right-justified | it |
Acquisition Time . TAD
Positive Voltage Ref | AVD
TAD: 2.5E-Ts
Negative Voltage Ref | AVSS -
I:‘ Enable ADC Interrupt
Selected Channels
Channel Custom Name Scan Enable
[aNs channel ANS ))

RB5Z ANSM I 7E K6 7 1% 36 58 LS Tow o

& 6: ADCTi H ADC15| JI%EJE

Notifications [MCC] | Pin Manager: Grid View |
Pacltage:|TQFP1-3(]|'| | Pin No: 17‘38‘58‘59‘w‘61‘91|32‘28‘29|66‘6}' 25|Z4‘23‘22‘21‘20‘26‘27|32‘
PortA Y PortB ¥
Module Function Direction [0 | 1|2 | 3|4 |5 6|7 |90 |10/14/15/ 0| 1|23 4{r5\'tl 6 7|8
A input SCEIRIAG S
ADClWY VREF+ input B
VREF- input B

DS50002446C_CN 251271
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K7: ADCTi H # IR —5| ISR

Projects | Files | Services |Classes Resource Management [MCC]

=1

Project Resources Generate || Import.. | Export

¥ System
Interrupt Module
Pin Module
System Module
¥ Peripherals

%ADCl [PIC24 / dsPIC33 / PIC32ZMM MCUs by Microchip Technelegy, Inc.]

& 8: ADCTji B /05| HIfE &

[ output sa| StartPage | PinModule % InterruptModule 2| SystemModule 52| ADC1 = EDEE
Pin Module L2 JE]
[ tro Sour] 5 Regirs
[Selected Package : TQFP100
Pin Name Module Function | Custom Mame | Start High Analog Qutput WFPU WFPD oD I0C
RAD Pin Module  |GPIO 10_RAD [ ]
RAL Pin Module  [GPIO 10.RAL D ]
RAZ Pin Module  |GPIO 10_RA2 n H|
RAZ Pin Module  |GPIO 10_RA2 ] ]
RA4 Pin Module  |GPIO 10_RA4 [ ]
RAS Pin Module  [GPIO 10,45 D ]
RAG Pin Module  |GPIO 10_RAG n H|
RAT Pin Module  |GPIO 10_RAT ] ]
RBS ADC1 ANS channel_ANS | | | | -
RBE& jloin} PGC2 l:‘ D l:‘ D
RB7 jlain} PGD2 l:‘ D l:‘ D

R QIS IIRAC:7 J5, BATK HBLE LRI 1 4.
RITAE 16 4% T RB5.

%1% #% RB6 Fl RB7 I T-iftE (5

— B HHIAER O H, BICAEA S A A sk 5 HEE .

© 2018-2020 Microchip Technology Inc.
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& 9. ADCHi B /05| %

Notifications [MCC] | Pin Manager: Grid View 2 |
Package':|TQFP1-30|'| | Pin No: 17‘33‘53‘59‘w‘51‘91|32‘23‘29|55‘57 25|24‘23‘22‘21‘20‘25‘27|32‘
PortAY PortB ¥
Module Function Direction (0 | 1|2 | 3| 4|56 9 |(10|14|15 01|23 |4 |5 6|7|8
Ahix input - A I I A O B
ADC1Y VREF+ input B
WREF- input B
CLKI input
CLKO output
Clock ¥ 0sCI input
QsCo output
SOSCI input
S0SCO output
S PGCx input i | a8
PGDx input B a8
S — input :_h'h'h'h'h'h'h - I T T A O A O B I B
GPIO output 6|6 A 6 A A A A) B BB BB DS S S

DS50002446C_CN 251

471
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& 10: ADCi H 5| it

Pin Manager: Package View [
F
3 2
33 B
=z 's
£2 s §
= B = o B = =
RfRc i AAES 8832228333883
.I_II_IU\_HJI_II_II_IU\_IUI_II_II_I“UI_II_H_IUI_IUI_II_I
10093 98 97 96 95 94 93 U2 91 G0 89 88 8/ O 85 &4 83 &2 &1 80 /Y /8 S/ /B
RG1s[ 1 s [Evss
von[ll: 7a[|rc1a
Rres[ 3 3[Orez
Rrea| |4 72[_|rDO
res[ s ® n[Jron
rc1[ e 70[|ro1a
re2[ ¢ 9 [roy
rea[ e sa[_|ros
Rea[ 19 5/ [ra1s
RG&[ 1o e6[|ra1s
re/[Ju c b5 [@vss
RGB:IQ I RDCHIP ﬁqEELKO
LRl s s3[re1z
real J14 &2 [jvop
vss[l1s 51 | Ras|io_ras|Grio
vop [l 16 PIC24FJ1286A010 &0 [|radiio rRad|GPIO
RAOJo_RaOGPIO[ ] 1/ 9 [Jrazpio_rasiGrio
reg| J1& sa[|raziio RaZIGRIO
Rrea[J1a 57 [re2
RBSlchannel ANSIANS] |20 s6[|RrG3
Re4[ a1 55 [ rre
R3[| ]2z sa[ |7
Re2[ )23 s3[rrs
REL[ ]24 s2[|rFz
reo[]zs s1[res
26 2/ 28 29 30 31 32 33 34 3b 36 3/ 38 39 40 41 42 43 44 45 46 4/ 48 49 50
Hininininininininininininininininininisisininimin
2T E22FZEREEELASEZREZEERSBESER
S 32*EZSY®CEEHYOELERNRREREGR VO3 2
[N ] [s)
(= 2
=
o
]
(=}
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IR R B e AR S, 15 B “Project Resources”  (TH % iE) & I LK)
Generate (R0 %41 (E7) . i@iEMCC ARSI AL . Bk, FRFAR
i RGACE A SMEARID IO T BB SO . ok, BEANMEEE B Ok St

A A BB B SO R ST A AR IR . R AR TR AN S A R b, (H 2 AR
Hh T PR SRR A

)R 7 AR I T R A6 44 T B4 madin . co T B G AR B SR LASR B AR R ARAS v mT B
e L (A AT R BB

11 JBiE MCCA ARSI ADCIR B #

Projects & | Files | Services |Cl.asses | Resource Management [MCC] =]
EI@ Exampled

E—}ﬁ Header Files

EE MCC Generated Files

E adcLh
- dockh
E interrupt_manager.h
E mec.h
E pin_manager.h
E system.h
E traps.h
E—}-E Important Files

b Makefile
o [lE MyConfig.me3
ﬁ Linker Files

=S ﬁ Source Files

EE MCC Generated Files

E adcl.c

E dock.c

E interrupt_manager.c
E mcec.C

E pin_manager.c
E system.c

E traps.c

E’ Libraries

E; Loadables

DS50002446C_CN 2516 11 © 2018-2020 Microchip Technology Inc.
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E12: JEiEMCCH B AIADCAES

TracefProfiling 3 | REALICE = |Example3(Bui\d, Load, ...) = |Debugger Console 22 | MPLAB® Code Configurator = »
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41 B¥UEHImain.cfRE

main.c MR X CE T, WRR. MoEBROMER (< >H) o Fima
main () HF RS DLER A IR
/‘k*

Generated Main Source File

<See generated main.c file for file information.>

*/

/*
(c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
this software and any derivatives exclusively with Microchip products.

<See generated main.c file for additional copyright information.>

*/
#include "mcc generated files/mcc.h"
unsigned int value = 0;

/*
Main application
*/
int main (void) {
// initialize the device
SYSTEM_Initialize();

while (1) {

// Wait for conversion -&—— FSNE427
// and then get result

while (!ADC1 IsConversionComplete());

value = ADC1 ConversionResultGet () ;

// Shift for MSb
value = value >> 2;

// Write to Port Latch/LEDs -—— FEWFE43T
LATA = value;

}

return -1;
}
/**
End of File
*/

DS50002446C_CN 251811 © 2018-2020 Microchip Technology Inc.
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42 ADCH¥M KRR

MCC & id 1% B AD1CON1 F 78 H I XAk sE ADC . 8 H H 2 R RE UL L FEH A
IR AN KA B B . FIE, main () AORD R 55 R4 45 TR FR IR AN 4
i adcl . cHHRP U T R %L

bool ADC1l IsConversionComplete (void)
uintl6 t ADCl ConversionResultGet (void)

AR EHALADC IR HIE R, 152 W (PIC24F RIS ) H) “517 & 10745
HiL#ds (ADC) 7 (DS39705A_CN) .

BT RAA8ALED A M, 1 ADCHH#E R Iy 104L, FIAZE value PRI K
AR AR R e 840, 7 B A TR .

4.3 BAMOYELSMLED
ADC ¥ ¥ s B value ¥ En7Eu AR LED .
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5. 7ELED I B/x EEPROM¥ (&
A48 F Microchip i PIC24F32KA304 PIM 5 Explorer 16/32 HI5 L, T~ i i 5
EEPROM%#li (EEData) . B:HUFIMEERTE M =A 0t H 15 I LED L.
i MPLAB RS EC 45 (MCC) KA RGBS . Bk T i anfif 22 2% MCC fiER Y MCC
HPfRErER, SR $475 “fifH ADCAELED FE/RHALIE” »
ARBIFEFMCC GUBR I E &G (IR A fERFC B M%) PLA I A, BAICHIE
/0 (General Purpose I/0, GPIO) ([13) . {HsE, MCCH HuT# A H T 16/ 4%
{4-f) EEData #3142 i .
1§ | EEData # 3 i 75 B ACRS 78 8% 44 24 F- M Al (dsPIC33/PIC24 #5122 F-t) M
“HE 5T MR EEPROM” Hrflt, 3350 T LA R # AR Ul
https://www.microchip.com/PIC24F32KA304

& 13: EEDATATH H B —R SiiER

Projects | Files | Services |Cl.asses | Resource Management [MCC] 22 =]

Project Resources Generate | Import.. | Export

¥ System

Interrupt Module
Pin Module
System Module
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& 14: EEDATAY H 2GR AECE

StartPage %y MPLAB X Store [ MPLAB® Code Configurator 5 L=

System Module 0 ©

lﬁif;‘ Easy Setup E Registers ;L, Metifications : 0

¥ INTERMAL OSCILLATOR

| 2000000 * | Hz | FRC Oscillator * | (B.0 MHz) Clock Source
v FRC Postscaler
8 MHz 11 +* | Postscaler

[ ] pLLEnable

8 MHz Fasc

4 MHz Fosci2

Clock Output Pin Configuration | CLKO cutput disabled b

|:| Use Secondary Oscillator (31 - 33)kHz

|:| Enable Clock Switching
D Enable Fail-5afe Monitor

¥ ICD

Emulator Pin Placement | EMUC/EMUD share PGC3/PGD3 -

¥ WATCHDOG
Enable | WDT disabled in hardware; SWDTEN bit disabled . ‘
Clock Settings |
Mode Standard WOT selected{windowed WDT disabled) -

Timer Prescaler | WDT prescaler ratio of 1:128 -

Timer Postscaler | 1:32768 >

Time-out Period  131.072s
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& 15: EEDATAT H %8 ——5] liEsR

Projects | Files |Classes | Resource Management [MCC] & [=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module

System Module

& 16: EEDATAJ} H /05| it &

StertPoge |}y MPLABX Store |5 MPLAB® Code C P EEBE
Pin Module e @
%}3} Easy Setup | 5 Registers | A\ Notifications: 0
Selected Package : TQFP44
Pin Name & Module Function Custom Name Start High Analog Output WPU WPD oD 10C ‘

RAZ Pin Module GPIO LEDD D D none | =
RALD Pin Module GPIO LED2 | | none | =
RALL Pin Module GPIO LED1 D D rone | =

RB2 Pin Module GPIO LEDE | H | O | none | =

RB3 Pin Module GPIO LEDT ] O Ol ] | rone |~

RES fray PGED3 O O O
RB6 €D PGEC3 ] ] | rone | -
RB12 Pin Module GPIO LEDS | O | O ] none | =

RCE Pin Module GPIO LED3 o | none | =

RCY Pin Module GPIO LED4 D D rone | =

ERM7 k5 RA9:11. RB2:3. RB12MIRC8:9/5, EATK A FME O,
izt £ RB6 F1RB7 A T- @[5 .
— H BB O, BIalheAN 5| A G Bk B 5 IR E .
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E17: EEDATAJ H /05| % IE

Output | Pin Manager: Grid (MCC] & |
Package:‘TQFPMl" ‘ Pin No: 19|20|3I)‘31|34‘18|7‘6|32‘35‘11|1! 21|2z‘23|24‘33|41|4;‘43|44‘1|x‘9|w‘11‘14|15 2;|25‘27|35‘37|33|2‘3|4‘5
PortA ¥ PortB ¥ PortC'¥
Module Function Direction |0 |1|2|3|4|5|6 7|8 9 (101101 | 2|3|4|5|6 78|09 10(11(12(13(14(15 0|1 2|3 4|5|[6| 7|89
PGCx input B
bl 4 oo p— w a .
CLKO output B
051 input B
oscY 05CO output B
SOSCI input B
S0SCO output B
orsrosney |5 input R N M T B B T T T B B T T A BT I B R MGG R RCRAC RCOC
&Flo sutput wlblb|Blb|- bbb 6 alawlbalenslsnlsnsnlabssslsslslnlsltalaa
RESET MCLR input a

&l 18: EEDATAA B 5[ st 3

Pin Manager: Package [MCC] & | [

=
- Lz
gz -
- E =

22 RESzEREZZ

[ B T S W v B, SR, TR - S i Y

.UI_IIJI_I.-.IJI_IUI_IU

44 43 42 41 40 349 38 3/ b 35 24

rReg| |1 33[|re4

res| ]2
il I E!
RCE|LEDZ|GPIO| |4
RCY|LEDAIGRIO] ]s

“H' MICROCHIP (2%~

Rae| ]/

re10[ s PIC24F32KA304 i

re1i_Ju RCO
RE12|LEDS|GPIO| |10 24 |rRB2|LEDT|GPIO
RE13 23[|rez|LEDe|GPIO

RAS
R
RAZ

slats

Fut
[

RC2

alats

L

14 15 1o 1/ 18 1% J20 A1 Jd
Himinininimininin
EEZZZEZEE
AW gL T T

olgolzaioTvd i
cldoltaatltove|_|=
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Fo e Bk % A E 2L S, 15 i “Project Resources” % I E ] Generate 14411 .
Wt MCC A BRI ARG R B Ak i) . IRk, EREFRIS . RGN AR 4L T

PSR BAh, AT H Rk

A A BB B SO R PIE AE ART IR . R AR T AN S A R, (H 2 AR
Hh T B 2 ST R R AE A

&19:

JBiE MCCA KRS EEDATATR H #%

Projects | Files |Ckasses Resource Manag... =]

=[G Examples

—[a:_‘| Header Files

—Gﬁ MCC Generated Files
E] interrupt_manager.h
IE-I mee.h

E] pin_manager.h

=g Important Files

b Makefile
[ MyConfig.me3
[a:j Linker Files

—ﬁ Source Files

& Gﬁ MCE Generated Files
|'|5|:‘| interrupt_ranager.c

BB mec.c

rF':‘] pin_manager.c

(g Libraries

E; Loadables

DS50002446C_CN 2524 1T
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GPIO A4 B XA BRI, A Z0fE pin manager . c HOR L B SO B4
A (BB51F) &

A4, BFLEDA REER—ANum A, Wi mE =m0 b, Bk EAE AN
A 5 SCFMRAE KoK 1E 7 1 LED B B 25 ot 1 51 Bl. Sk F LEDs .h (355.2715) AIC
VA LEDs.c (Z£5.37) OB A+,

WEISCHTIR, MCCH BHai& A T 168344 ) EEData 234 B IR, R EF3)
WIS . Sk eedata.h (555.475) MIC X ffeedata.c (F5.5%) DN
Hrho

B &35 H R i lE] 20 B

& 20: EEDATAT EW —& 4

Projects 2 | Files |Cl.asses Rezource Manag... [=]
=M= WEvample5

E—}ﬁ Header Files
i eedata.h

3 mech

E-(&g Important Files

b Makefile
L..[E8 MyConfig.mc3

[a:j Linker Files

[—}-ﬁ Source Files

o I eedata.c

BB mec.c

(g Libraries

E; Loadables

I FE PP R IR N T RERT SR 24 75 Z i main. ¢ (B55.6711) o 1A AL AU STHE R nsc
P LR B 885 R ACRS A R] B 5 ZE (KA ] R B

© 2018-2020 Microchip Technology Inc. DS50002446C_CN 52571



H AR TR MPLAB® XC16 F A 155

51 #BH#)5HMpin_manager.cfH
main.c MR SCAF A i, R AR, SMAERRMA RPN AECHER (<>H) .
ARG AR (1 R
/**
System Interrupts Generated Driver File

<See generated pin manager.c for file information.>

Copyright (c) 2013 - 2015 released Microchip Technology Inc. All
rights reserved.

<See generated pin manager.c for additional copyright information.>

*/

/x*
Section: Includes
*/
#include <xc.h>
#include "pin manager.h"

/**
void PIN MANAGER Initialize (void)
*/
void PIN MANAGER Initialize (void) {

<See generated pin manager.c for port setup information.>

/********************************************************************

* Setting the Analog/Digital Configuration SFR(s)
********************************************************************/
ANSA = 0x0;
ANSB = 0x0;
ANSC = 0x0;
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5.2 LEDs.h/\hg
EAERCMER (<>H) .

* PICF32KA304 LEDs header

*

* (c) Copyright 1999-2015 Microchip Technology, All rights reserved
*
<See generated header files for additional copyright information.>

*/

/********************************************************************

* Union of structures to hold value for display on LEDs
* LAT LEDx - bit fields of value
* w - entire value
*******************************************************************/
typedef union {
struct {
unsigned LAT LEDO:
unsigned LAT LEDI:
unsigned LAT LED2:
unsigned LAT LED3:
unsigned LAT LED4:
unsigned LAT LED5:
unsigned LAT LEDG6:
unsigned LAT LED7:
bi
struct {
unsigned w:16;
bi
} LAT LEDSBITS;
extern volatile LAT LEDSBITS LAT LEDSbits;

~e N

.~

~e Ne N

el e e
-~

~.

/* LAT LEDSBITS */

#define LEDO LAT LEDSbits.LAT LEDO
#define LED1 LAT LEDSbits.LAT LED1
#define LED2 LAT LEDSbits.LAT LED2
#define LED3 LAT LEDSbits.LAT LED3
#define _LED4 LAT LEDSbits.LAT LED4
#define LED5 LAT LEDSbits.LAT LED5
#define LED6 LAT LEDSbits.LAT LED6
#define LED7 LAT LEDSbits.LAT LED7
#define _LEDS LAT LEDSbits.w

/********************************************************************

* Function: DisplayValueOnLEDs

* Precondition: None.

* Overview: Display input value on Explorer 16 LEDs

* Input: Value to display

* Output: None.
*******************************************************************/
void DisplayValueOnLEDs (unsigned int wvalue);

/**

End of File

*/
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5.3 LEDs.cfthg

TR CMER (<> .
/**
Display on LEDs Source File

<See LEDs.c for file description information.>

*/

/*
Copyright (c) 2013 - 2015 released Microchip Technology Inc. All
rights reserved.

<See generated header files for additional copyright information.>

*/

#include "mcc generated files/mcc.h"
#include "LEDs.h"

volatile LAT LEDSBITS LAT LEDSbits;

/********************************************************************

* Function: DisplayValueOnLEDs

* Precondition: None.

* Overview: Display input value on Explorer 16 LEDs
* Input: Value to display

* Output: None.

*

******************************************************************/

void DisplayValueOnLEDs (unsigned int wvalue) {

_LEDS = value;

_LATA9 = LEDO;
_LATA10 = LEDI1;
_LATAll = LED2;
_LATC8 = LED3;
_LATCY9 = LED4;
_LATB12 = LED5;
_LATB2 = LED6;
_LATB3 = LED7;

}

/**

End of File

*/
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5.4 eedata.h/VHg
HERCMER (<> o

* PICF32KA304 Data EEPROM header

*

* (c) Copyright 1999-2015 Microchip Technology, All rights reserved
*
<See generated header files for additional copyright information.>

*/

/********************************************************************

* Function: EEData WTL

* Precondition: None.

* Overview: Write one word of EEData

* Input: Action to take: Erase or Write, Data to write
* Output: None.

*******************************************************************/

void EEData WTL(unsigned int action, unsigned int data);

/***********************************k*********************************

* Function: EEData Erase

* Precondition: None.

* Overview: Set up erase of one word of EEData
* Input: None.

* Output: None.

***********************************k********************************/

void EEData Erase (void);

/********************************************************************

* Function: EEData Write

* Precondition: None.

* Overview: Set up write of one word of EEData
* Input: Data to write

* Output: None.

*******************************************************************/

void EEData Write (unsigned int data);

/********************k***************k*********************************

* Function: EEData Read

* Precondition: None.

* Overview: Read one word of EEData
* Input: None.

* Output: Value read from EEData

***********************************k********************************/

unsigned int EEData Read(void);

/**
End of File
*/
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5.5 eedata.c/Vlg

HaERECHER (<>H) .
/‘k*
Data EEPROM Write and Read

<See eedata.c for file description information.>

*/

/*
Copyright (c) 2013 - 2015 released Microchip Technology Inc. All
rights reserved.

<See generated header files for additional copyright information.>

*/

#include <xc.h>
#include "eedata.h"

#define ERASE EEWORD 0x4058
#define WRITE EEWORD 0x4004

int  attribute  ((space(eedata))) eeData = 0x0;
unsigned int offset = 0x0;

/***********************************k*********************************

* Function: EEData WTL

* Precondition: None.

* Overview: Write one word of EEData

* Input: Action to take: Erase or Write, Data to write
* Output: None.

*

**********************************k********************************/

void EEData WTL (unsigned int action, unsigned int data) {

// Set up NVMCON to write one word of data EEPROM
NVMCON = action;

// Set up a pointer to the EEPROM location to be written
TBLPAG = builtin tblpage (&eeData);

offset = builtin tbloffset (&eeData);

~ _builtin tblwtl(offset, data);

// Issue Unlock Sequence & Start Write Cycle
__builtin write NVM();

// Wait for completion
while (NVMCONbits.WR) ;

/********************************************************************

* Function: EEData Erase

* Precondition: None.

* Overview: Set up erase of one word of EEData
* Input: None.

* Output: None.

*

******************************************************************/

void EEData Erase(void) {

EEData WTL(ERASE EEWORD, 0);
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/********************************************************************
* Function: EEData Write

* Precondition: None.

* Overview: Set up write of one word of EEData

* Input: Data to write

* Output: None.

*

******************************************************************/

void EEData Write (unsigned int data) f{

EEData WTL (WRITE EEWORD, data);

/********************************************************************

* Function: EEData Read

* Precondition: None.

* Overview: Read one word of EEData
* Input: None.

* QOutput: Value read from EEData

*******************************************************************/

unsigned int EEData Read(void) {

// Set up a pointer to the EEPROM location to be read
TBLPAG = builtin tblpage (&eeData);
offset = builtin tbloffset (&eeData);

// Read the EEPROM data
return  builtin tblrdl (offset);

/**
End of File
*/
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5.6 BXEKmain.c/ViE
main.c RS CAS M, WTFAR. MEROMER (< >0 o SdmmRnm
PLZR A IR o
/‘k*
Generated Main Source File

<See generated main.c for file information.>

*/

/*
(c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
this software and any derivatives exclusively with Microchip products.

<See generated main.c for additional copyright information.>

*/

#include "mcc generated files/mcc.h"
#include "eedata.h"

#include "LEDs.h"

#include "libpic30.h"

#define IC DELAY 1000000

unsigned int data write = 0x0;
unsigned int data read = 0x0;

/*
Main application
*/
int main (void) {
// initialize the device
SYSTEM_Initialize();

while (1) {
data write++;

// Erase one word of data EEPROM -—— {FZ&WES7H
EEData FErase();

// Write one word of data EEPROM
EEData Write(data write);

// Read one word of data EEPROM -&—— {FZNL555.87
data read = EEData Read();
// Display result on LEDs -—— EFEEE597

DisplayValueOnLEDs (data read) ;

// Delay change on LEDs so visible
__delay32(IC _DELAY); // delay in instruction cycles

return -1;
}
/**
End of File
*/
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5.7 #FR¥H S ANEEData

T{E EEData 5 N AT, AUENE LT F

1. BEBR— %4 EEPROM £,

2. KR 5 N4 EEPROM /745 -

3. W HdE T4 FEE| EEPROM.

HT# kR EEData - 5 N — M7 T eedata. c 1 (BE5.571) &

XF T PIC24F32KA304 &3 1, {E#E KR8l '5 NEEData < i, & ZH— MEHFIIEA
NVMKEY (ZENVMCON*HD .

5 P P L R K T A i )

e unsigned int  builtin tblpage(const void *p);

e unsigned int  builtin tbloffset (const void *p);

e void builtin tblwtl (unsigned int offset, unsigned int data);

e void builtin write NVM(void);

ok X s pR B VA 15 B, i 2 WL (MPLAB® XC16 C4i % 2% F /1 45 )
(DS50002071E_CN) iz G “WERE” .

5.8 i{ZEXEEData

XA, 5 NEEData5, #i%HEEData 5.

HIT 1 EEData i) — M RIS T eedata. e (5.5 .
i I A B B BOR AT 2 D -

e unsigned int  builtin tblpage(const void *p);

e unsigned int  builtin tbloffset (const void *p);
* unsigned int  builtin tblrdl (unsigned int offset);

AR X e K E R, 1 2 WL (MPLAB® XC16 C4 i % A /48 B)
(DS50002071E_CN) [HFf5%G “HNE R .

59 7ELED L B/R¥EUE AR ER

FEMH AR LED b R B0 T 801 5 AR IR, BRI = AN H35 5 LED & #%
I, TG RIS M E SR, DU AT DU 4 M 448 (LAT LEDSbits.w) ,
Z G BT LA VT I & AN A, DAE R L ME 48 OF i e O 51 B AT BoR (il
LATAbits.LATA9 = LAT_LEDSbitS.LAT_LEDO) o

T Ol BA F 4 RIS T LEDs . h b (B55.2715)

FIT- LED B A 25 3 51 B ARRS A2 T LEDs . e (B5.371)

H T AT B TE K 22 U1 0 T #B 2> 5 B LED I I MR B R N AR B0 RE 1), BRI
ZEERAEA_delay () B (552795 REEIRHTERE .
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A. 7EMPLAB X IDEH iZ4T40HE

A1 BIETA:
o, fE—-A0H:
1. JB3JMPLAB X IDE.
2. MIDEHEBEETH S (File>New Project (SCF>#ETH) ) .
3. MR RRR O — M -
a) Choose Project GEFE TN H) : %% “Microchip Embedded” (Microchip
AR , #RJEi%EHF “Standalone Project” (JRAZIH) o
b) Select Device GEFEBMF) : EFRGIZT.
c) Select Header GEFAIAL) : L.
d) Select Tool GEHTHE) : /755 (Serial Number, SN) SNXxxxxxi%
PR TR, RS TR AR N ARE RSN, iEH AR LA CIE
¥, FREMEE, HS IR T H .
e) Select Plugin Board GEFERER) : L.
f) Select Compiler GEREGERR) : ELFHEXC16 (RFKAE) [binXiFIAL
Blo WMRXC16 T AT RS, TH RS 1% 25 O 1L 2% HMPLAB X IDE
AR B AT SO %% Tools>Options (T B> k%) , .7 Build Tools
(¥ T H) % - Embedded (Tl 7%2% T H) #4H, #3541 9 %
B HRWEMEE, 152 ILMPLAB XC16 f1MPLAB X IDE SCH#4.
g) Select Project Name and Folder GEREINE ZFICHFR) « NIHGH.

A2 EBEEBHCHEO (CCD

Bl e H 5, A Projects (JH) & LRI H 4 F7 ik #% Properties (J&
) o FEXTIEHER, i “xc16-gec” FKill, 1EFF “Preprocessing and messages”
(PRALFRANGY S REIEH], Fikrt “Use CClsyntax” (fii ] CCIiEVE) EikHE. #
HOK (HiE) %4l

A3 AR
MR H s AT DL B2 —
1. Tl 2F3, GO R AT BIAAD :
a) Ay diProjects® I “Source Files” 3. kFENew>main.c CGHi
#H>main.c) . HITIHF “New main.c” CHrEmain.c) XHEHE.
b) f£ “File name” (fF4) FHIANAFR (Wexamplen) , A Fin il
=
c) HdiFinish (58 « HAEgmE S & L R T F 0.
d) BRSO RIS . SR G AR FH P 38 FF A B U1 s AR AL R S 2 2= A 4
mesE O, ikt File>Save (CHE>{#1F) .
2. KT R4 15, TEREREE T I U0 A MCC A s, 2R )5 H A s ARG
YmiEmain . c ORI SO .
BeJ, 1EPeDebug Run CIRRIZAT) it FEAEIB b, FFATAUD. JEitw
N ELEDFPIRSEF M. HdiHalt GBS g T,

1-1: LA AR
) =
|Del::|ug Main F'rcuject| |Fini5h Debugger Session (Shift+ F5]|
Wizt iy
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B. ZREUHIFANBEF

ST AR MPLAB XC16 1 H , 24 PIC24F PIM ] Explorer 16/32 % H1 9V #h 6 £,
VAL, JREE AR (ICSP™) J8{5. #H MPLAB X IDE #H7H % .

B.1 #KE(MPLAB X IDE il MPLAB XC16 C %; %53
A LA R R 4E4R E] MPLAB X IDE v5.10 % BL I i A

https://www.microchip.com/mplab/mplab-x-ide

A LA P4 2] MPLAB XC16 C 4 i85 v1.35 & LA L Ji A :
https://www.microchip.com/mplab/compilers

B.2 ZREYMPLABAISECE R (MCC)
AL P HER EIMCC v3.66 A L R A :
https://www.microchip.com/mplab/mplab-code-configurator
B.3 #KEXPIC® MCUE:H#&LR (PIM)

Microchip Technology Wi I 11 LA~ A7 B $2 44t 1 745 s F (1 PIC MCU PIM:
PIC24FJ128GA010: https://www.microchip.com/MA240011
PIC24F32KA304: https://www.microchip.com/MA240022

B.4 3KEXIi E Explorer 16/32#%

Explorer 16/32 FF & ik« Ji B B A0 SRS ] AL (kR 2«
https://www.microchip.com/dm240001-2

TERIIHE TR R E
F1-1:  TH KBk OT ik
Bhsk 17155 prirke 2 Bk 1 1% P

JP2 A J37 Wi
J19 Wi It J38 Wi FF
J22 Wi T J39 BRI
J23 LN Ja1 isis
J25 Eiks J42 Wt
J26 ey J43 BRA
J27 Wi FF Jaa BRI
J28 Wi FF Ja5 BRI
J29 Wi T J50 Gikes
J33 Wi FF

B.5 3REMicrochip ik T E
AILEAN S FF R T B T AR 4R 2147 4 AR X A5 -

https://www.microchip.com/development-tools
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< HED, EEEERE. HEERANABIARD R DIREMAT . SIRATATA, BT X AT AN L Microchip B Tkt HLE
HAERTERAL FH Microchip 7 St iK1 IXAE I AR AT BEARIC T AR AL

*  Microchip J& 5 A eyt FARRS 52 B (%5 A1

+ Microchip SAEfTHA - G4k B TCIA GRIE AT 22 &2k AR ORI IF A BIRE TATIRIE ™ e “ AW 1.
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RS RSO TEFEE . BB EE
MIESCERSY, BAFEHIRAL T A 2R Microchip 7= M fEREFIH
&L FI5 8 . Microchip Technology Inc. %344 R FIAH
RAF, FREEE R T REBZREHAMN BECHE RN
T ZERABEMFE. BIXS*E Microchip Technology
Inc. BIZESTRERR SO .

A R I B 28 B ME R R E AR AR IS SR LA
Fl, EATATRER R 2B BT B B RS BRI,
REE SR AMTE. Microchip MiX (5 B AEET B RER
Bon. PEFOL. e apRnEHgEg, akEeEs
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